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Today, Tableau is one of the most crucial tools strong-handedly ruling the software and business workplaces around. In the competitive world, the more you know about the tool, the more the chances of you getting recruited. As we know that Tableau increases the weightage to your resume, here we are presenting the compilation of 101 Important Tableau Interview Questions and Answers that help the freshers to ace the Interview. Ready?

Tableau is a BI software that helps in visualizing the data in graphical format and helps in creating the interactive and shareable dashboards. It makes the understanding and analysis of the data easy for the user. It helps the business users in engaging with the data, to ask questions, and solve the problems.

So, we know that it is a bit tough to crack interviews, although you have a good knowledge of this particular skill. To boost up the confidence levels in you, we strongly suggest you go through our predicted and reliable compilation of 101 Tableau Interview Questions and Answers which helps in polishing the basic knowledge much stronger.






What is Tableau?





Tableau is a data visualization tool (like presenting the data in the form of dashboards) that helps in simplifying the raw data into the user understandable format. It is widely used in the Business Intelligence Industry.









Is the software ‘Tableau’ available for free?





Yes. You can upload a file that contains the data or a spreadsheet to the ‘Tableau Public’, a free Tableau software, which helps in converting the data into the interactive visualizations for easy understanding and analyzing. Another free Tableau tool is ‘Tableau Reader’.









Tableau Software Company was founded by?





Christian Chabot, Pat Hanrahan, Chris Stolte, Andrew Beers together founded the company Tableau Software in January 2003, in Mountain View, California.









Tableau Software Company’s current headquarters is in?





Tableau Software Company’s current headquarters is located in Seattle, Washington, United States. The current CEO of this company is Adam Selipsky.









Name any three best features of Tableau.





	Data Blending
	Real-time analysis
	Collaboration of data










With Tableau, are there any size limitations?





No! We can import the data with no limitation of rows and columns.









Is there any data limitation with the Tableau Public?





Yes. In Tableau Public allows only 10M rows to perform the visualizations.









Name some File Extensions in Tableau.





	Tableau Workbook (.twb)
	Tableau Data extract (.tde)
	Tableau Datasource (.tds)
	Tableau Packaged Datasource (.tdsx)
	Tableau Bookmark (.tbm)
	Tableau Map Source (.tms)
	Tableau Packaged Workbook (.twbx)
	Tableau Preferences (.tps)










Tableau Desktop’s latest version is?





Tableau Desktop’s latest version is 2020.3 released on the 11th of August, 2020.















In Tableau, LOD stands for?





In Tableau, LOD stands for ‘Level of Detail’ Expression. These are the commonly asked Tableau Interview Questions and Answers for the fresher candidates in an Interview.









Define LOD.





Level of Detail (LOD) is an expression that helps in running the data that contains many dimensions at the data sourcing level. It runs complex or difficult queries.









What does the tableau product suite consist of?





	Tableau Desktop
	Tableau Public
	Tableau Online
	Tableau Server
	Tableau Reader










Define Data Visualization.





Data Visualization is a technique that is used to represent the data into the graphical format by encoding. This technique helps the user to analyze and understand the data easily. The best examples are bar charts, pie charts, histograms, etc.









Define the Developer tools in Tableau.





In Tableau, Developer tools are the tools that help in developing the visualizations, reports, dashboards, and charts.










Define the Sharing tools in Tableau.





In Tableau, Sharing tools are the tools that help in sharing the visualizations, reports, dashboards, and charts that are developed using the Developer tools.









The Tableau products that fall under the category of developer tools are?





	Tableau Desktop
	Tableau Public










The Tableau products that fall under the category of sharing tools are?





	Tableau Online
	Tableau Server
	Tableau Reader










Define ‘Tableau Desktop’.





Tableau Desktop is a product or a feature that helps in coding as well as in customizing the reports. This tool works in creating the visualizations like charts, reports, or the blend of them into the dashboards.









Tableau Desktop is mainly classified into how many types?





Tableau Desktop is mainly classified into two types, namely:

	Tableau Desktop Personal
	Tableau Desktop Professional










Where can the workbooks of the Tableau’s Desktop Personal be distributed?





The workbooks of the Tableau’s Desktop Personal can be distributed either in Tableau Public or in Offline. These are the frequently asked Tableau Interview Questions and Answers for the experienced candidate in an Tableau Interview.









Where can the workbooks of the Tableau’s Desktop Professional be distributed?





The workbooks of the Tableau’s Desktop Professional can be distributed either in Tableau Server or in Online.










What is the main difference between Tableau desktop personal and professional?





The workbooks of the desktop personal can’t be published online, whereas the workbooks of the desktop professional are ideal to be published online or on the Tableau server. Additionally, Desktop Professional can access all sorts of data types, where Desktop Personal can’t.









Define the Tableau Public





Tableau Public is a product of a feature that helps in making the workbook available for all to access and download by placing the workbook in the Public Cloud of Tableau. This feature is cost-effective.









Can we save the workbooks locally using Tableau Public?





The word ‘Public’ says it all. No, we can’t save the workbook locally. Instead, it uploads the workbooks into the Public cloud of Tableau through which anyone can access or download the uploaded workbook.









Define the Tableau Reader..





It is the feature or a product or a tool that is available for free. It allows you to view the visualizations and workbooks that are created using the Tableau’s Desktop or Reader. Data filtering can be made. However, modifications upon the data are restricted.









Define Filter





A filter is a tool that helps in removing or restricting an unnecessary set or a range of data present in the dataset. It helps in providing accurate details.









What are the types of filters that are used in Tableau?





	Quick Filter.
	Data Source Filter.
	Context Filter.










How do you remove the ‘Show All’ option from an Auto Filter in Tableau?





To remove the ‘Show All’ option from an Auto Filter, we need to follow the path:

Right-click on Filter -> Customize -> Uncheck the ‘Show All’ option.









What are the connection types available in Tableau?





	Extract Connection
	Live Connection










Define the Extract connection





Extract connection deals with the snapshot of the data taken from the data source and upload it into the repository or the folder of the Tableau.Important Tableau Interview Questions and Answers  that are put forth to freshers and experienced candidates in an interview. 









Define the Live connection.





Live connection deals with the creation of a direct connection to the data sources, such that the data can be directly fetched from the tables with fast access speed.









 Tell us an advantage of the Extract file over the live connection in Tableau?





Using the Tableau Extract file, we can create the visualizations anywhere without connecting to the database. We can use these files without any connection, anywhere, and anytime.










Tell us the major difference between .twb and .twbx file extensions.





The .twb file takes the data live and the one who receives these files needs to get the permission to access, whereas the .twbx file takes the data offline and stores it in the zip file format. So, the .twbx file is permission free to access.









How many tables can we join maximum in Tableau?





There is a limit for the number of tables we can join in Tableau ultimately. We can join up to 32 tables. We can’t combine more than 32 tables in Tableau.









In Tableau, Joins can be performed in how many ways?





In Tableau, we can perform the Joins in two ways, as in

	Using common columns
	Using common data types










In Tableau, Joins are divided into how many types?





In Tableau, Joins are mainly categorized into two types, namely:

	Equi Join
	Non-Equi Join










 Define Equi Join.





Equi Join is a type of Join in which we use the ‘=’ operator to match and join the records of two tables.









What are the different categories in ‘Equi Join’?





There are three categories present in ‘Equi Join’, namely:

	Inner Join
	Outer Join
	Self Join










Define the Inner Join.





Inner Join is one of the categories of ‘Equi Join’. It helps in loading the records that match in both the tables, strictly.

tablea.id = tableb.id









Outer Join is categorized into how many types?





Outer join is classified into three types, namely:

	Left Outer Join
	Right Outer Join
	Full Outer Join 


These are the Important Tableau Interview Questions and Answers asked for fresher candidates in an Interview.









Define the Left Outer Join.





The Left Outer Join is one of the categories of Outer Join that displays all the records from the left table along with the MATCHED records from the right table.









Define the Right Outer Join.





The Right Outer Join is one of the categories of Outer Join that displays all the records from the right table along with the MATCHED records from the left table.









Define the Full Outer Join.





The Full Outer Join is one of the categories of Outer Join that displays complete data from both the tables.

table A full outer join table B ON tablea.id = tableb.id









Define the Self Join.





Self Join is used when we want to perform the Join operation on a table with itself.









Define the Non-Equi Join.





Non-Equi Join is a condition in which we join the tables using the conditions containing any operator other than “=”. The operators we use here can be <, >, <=, >=, and =!.









What is data blending in Tableau?





In Tableau, Data Blending is a technique that is used to mix the data from multiple data sources into a single sheet, making it easier for the users to perform the analysis on the data. 









Tell us any two rules of Data Blending.





When we are performing the data blending technique coupon two different data sources, they both should contain at least one common dimension.

In each common dimension, there should contain at least one matching class or value.









In how many ways can we perform the data blending?





We can perform the data blending technique in two ways, namely:

	Automatic way
	Manual or Custom way.










What is the difference between Automatic blending and Custom blending?





Automatic blending helps in automatically defining the relation between the two different data sources based on the matching values and common dimensions, whereas, in Custom blending, the user defines the relation manually.









What are the functionalities of the data blending?





	The primary and secondary data sources are linked with each other by a specific relationship, be it user-defined or automated.
	Every worksheet must have a primary connection. A secondary connection number is optional.
	In the worksheet, the primary connections are indicated in blue color while the secondary connections are represented with an orange tick mark.
	In the worksheet, the secondary data sources can be multiple, but it should have one primary data source. These are the commonly asked Tableau Interview Questions and Answers for the freshers and experienced candidates in an interview. 










Define Dimensions





In Tableau, the descriptive data columns present in the worksheet are known as the Dimensions. The product names, city names, etc are the examples.









Define Facts.





In Tableau, the measurables such as numerical values are known as Facts. The profit rate, discount, sales, etc are examples of the facts.









Define the heat map.





The Heat Map is a data visualization tool that helps in comparing the two different measures, using color and size for easy understanding.









Define the treemap





TreeMap is one of the most powerful data visualization tools. It helps in comparing the two different data measures using the nested rectangles by illustrating the hierarchy data.









Why do we use dual axes?





In Tableau, Dual axes are used to display the two data measures in a single graph.









Define blended axes





Blended axes are the axes in which we can display the multiple measures in a single axis. Here, we can place all the marks in a single pane.









How to go for blended axes?





	Firstly, Drag a dimension in a column
	Secondly, Drag the first measure in the column
	Thirdly, Drag the second measure in the existing axis
	Lastly, use Us/multiplemeasures_blendedaxes.html










In Tableau, can we perform testing?





No. As Tableau is a data visualization tool, we cannot perform testing in it.
















How do you use the parameters in Tableau?





In Tableau, we use the parameters with

	Filters, 
	Calculated fields, 
	Actions, 
	Measure-swaps, 
	Changing views,
	Auto-updates.










Is it possible to view the top ten and the last ten sale values in the same view?





Yes. In Tableau, we can display the top ‘x’ values and the bottom ‘y’ values using the filters or the calculated fields. These are the frequently asked Tableau Interview Questions and Answers for a fresher candidate in an interview.









How to display the top ten and the last ten sale values in the same view?





	Create a view which contains the top 10 records
	Create another view which contains the bottom 10 records
	Create a view by joining the above views.










Condition: I want to display sales and profits as a chart that shows the region-wise sales and profits. How can I do it?





Generate a map of cities -> Drag the columns of profits and sales to the details -> Add ‘Quick filter’ state.









Condition: I want to add the custom color. In Tableau, how can I do it?





	In Tableau’s 9.0 version, the color picker option is available. We can use it.
	Else, we need to create a custom color code as follow:


Documents -> My Table Repository -> Preferences.tps









How does tableau help business users?





	For easy understanding and analyzing,
	In engaging with their data,
	In asking questions,
	In solving problems,
	In creating values.










Condition: I want to combine a database and the flat file data. How can I do it in Tableau Desktop?





	Firstly, we need to connect the data twice, one for the DB tables and one for the flat file.
	Then, go for Data-> Edit Relationships
	Lastly, give a join condition upon the common columns from the database tables to the flat file.










Define Data Modeling.





Data modeling, the first step to be performed in OOP, is the data object analysis and helps in identifying relationships among these data objects.









Define parameters.





Parameters are the changeable or dynamic values that help in replacing the values of the constants in making the calculations.









Tell us about the common work process of Tableau.





The daily work process goes in this flow:

	Requirement analysis,
	Getting the required data,
	Creation of a storyboard, 
	Creating the visualizations in Tableau, 
	Presenting the visualization in front of the client for review.










How the performance effects based on the size of datasets?





If the size of the datasets is medium, the data source takes minimum time to execute the query. If we take a huge dataset, the execution time of the query becomes more and the Tableau should wait till the execution completes. So, the performance depends upon the size factor too.









Condition: I want to publish and schedule a workbook in Tableau Server. How can I do it?





Create a schedule -> Create an extract for the data source -> Click ‘Scheduling and Authentication’ option -> Select the schedule from the drop-down -> Publish. The above are the Important Tableau Interview Questions and Answers that are put forth to the freshers and experienced candidates in an interview. 









Define Page shelf





Page Shelf is one of the powerful tools of the Tableau that is used to control the display and the results to be printed on the output.









Tell us one major difference you find between the versions Tableau 7.0 and Tableau 8.0.





	Visualizations such as treemap, bubble chart, and box and whisker plot are added in Tableau 8.0 version.
	Direct copying of one workbook to another workbook is enabled.
	Introduction of the R script.










How can we create the filled maps in Tableau?





Build a Map View -> Double-click on a geographic field -> Select the Filled Map Mark Type -> Drag a Field to the Color shelf -> Drag another field to the color shelf and define the phenomena of coloring the locations.









Parameters have their own drop-down list. True or False?





True. Parameters can have their own drop-down lists. In the creation of the parameters, we make entries. Those entries can be viewed as a drop-down of the respective parameter.









Tell us a major difference between the INDEX and RANK.





In Tableau, INDEX deals with the position of the record, whereas RANK deals with the data or the value present in that record. INDEX value goes on incrementing by one on every next record, and RANK is based on the value. The highest value gets the highest rank, whereas the lowest value gets the last rank.









Name the data types used in Tableau.





	String
	Number (Whole)
	Number (decimal)
	Boolean
	Date
	Date & Time
	Geographic Values










Give examples of various data types in Tableau.





	String: ‘Database’, ‘Hello World’
	Number (Whole): 9754, 52, 0
	Number (decimal): 1233.23
	Boolean: TRUE, FALSE
	Date: “12/09/2020”
	Date & Time: 12 September 2020 01:35:00 PM
	Geographic Values: India, China, Mexico










Define Story





In Tableau, Story is a group of worksheets and dashboards that helps in the analysis and insights of the data.















What is the use of creating a story?





The story is useful in displaying the relationship between the facts and the outcomes that affect the decision-making process.









Tell us the ways you follow to improve the performance of the Tableau.





We can improve the performance of the Tableau

	By hiding the unused fields
	By using the content filters
	By reducing the scope of the data
	By using an extract to make the workbooks run faster
	By reducing the filter usage
	By using the indexing in the tables
	By using the same fields for filtering
	By removing the unnecessary calculations and sheets.










Define the Mark card.





The Mark card is present on the left side of the view into which we can drag the fields and the control mark properties like:

	Color, 
	Size, 
	Type, 
	Shape, 
	Detail, 
	Label,
	Tooltip.










What do you mean by the Bullet graph?





Bullet graph deals with the comparison of one data measure with the other measures and is one of the variants of the bar graph.









What is meant by the Gantt Chart?





Gantt Chart displays how the value changes over the period in the form of bars along the time axis.









What is meant by the Histogram?





Histogram is a graphical visualization chart that represents and displays the continuous data that happened in a specific period.









 Condition: I want to download the Tableau Public. How can I do that?





	Go to public.tableau.com 
	Enter your e-mail address
	Click “Download the App”
	Once the file is downloaded, run it
	Follow the prompts to install the Tableau
	Go for the Tableau shortcut on your desktop
	Icon -> Double Click = Loading of Tableau










  What is the major difference between the tiled and floating layouts?





In dashboards of Tableau, the Tiled layout is a layout in which the items doesn’t overlap and adjusts itself based on the dashboard size, whereas the Floating layout is a layout in which the frames can be placed on the other frames, as well as they can be fixed to a position.









Dimensions are categorized into how many types?





In Tableau, the dimensions are categorized into 9 types, namely:

	Slowly ever-changing Dimension
	Chop-chop ever-changing Dimension
	Unchanged Dimension
	Shrunken Dimension
	Junk Dimension
	Conformed Dimension
	Degenerated Dimension
	Role enjoying Dimension
	Inferred Dimension










VIZQL refers to?





VIZQL refers to ‘Visual Inquiry Language’.









Define Visual Inquiry Language.





Visual Inquiry Language is the combination of the VIZ and SQL. VIZQL is a language that converts the queries into the visual images.









List the components we find in the dashboards.





Mainly, we find 5 components in the dashboards, namely:

	Web
	Horizontal component
	Vertical component
	Image Extract
	Text










Define Discrete data roles..





Discrete data roles consist of the separate and distinct values that can take independent values within the range. They can be sorted. These are the commonly asked Important Tableau Interview Questions and Answers for the freshers and experienced candidates in an interview. 









Define Continuous data roles.





Continuous data roles consist of the values situated in the finite or infinite intervals. Here, the continuous fields can’t be sorted.









In Discrete data roles, the Order Quantity field is colored in?





In Discrete data roles, on the columns shelf, the Order Quantity field is colored in blue.









In Continuous data roles, the Order Quantity field is colored in?





In Continuous data roles, on the columns shelf, the Order Quantity field is colored in green.









Tell us any two reasons for the low performance of Tableau.





	Using filters unnecessarily.
	Live connection reduces the performance compared to the extract connection.
	Loading the wrong data source reduces performance.










Global filters can be applied on?.





	Sheets,
	Stories,
	Dashboards.










List any three charts that we should avoid using?.





	3D Charts
	Pie Charts
	Donut Charts










How do you handle the null values in the Tableau?





	By using the ‘Filters’.
	By replacing the null values with any default value.










Tell us a way with which we can use groups in the calculation field?





Select Analysis -> Click the calculated field -> Enter the field name -> Enter the calculation -> Click Ok.









Can we install Tableau on macOS?





Both the Windows Operating system and macOS supports the Tableau installation.









List the challenges we face when we load huge volumes of data into Tableau





	Slows the run time.
	Testing becomes complex.
	Data Extraction.
	Alignment issues.








Tableau is a vast topic, an ocean. We have tried to cover almost every topic with the motto of preparing you to face the Interview Questions on the ‘Tableau’ topic, strongly. However, these 101 questions are the most popular and are predicted to be asked in the interview, by our team. We think that these lists of Interview Questions will help you. Hope you will ace the interview questions asked on ‘Tableau’ with your answers. Good luck! Besides these interview question, Tableau Training in Chennai  or Tableau Training in Bangalore at FITA offers the best-in class training for the Tableau to widen your career horizon and to have a holistic understanding of the Tableau concepts





           
    
    
    


  

    

  




  
    
      
        ×
        REGISTER

      

      
         


 














	Quick Enquiry
	

	





Select the Branch
Classroom Training - Chennai
Anna Nagar
Tambaram
T Nagar
Thoraipakkam
Velachery
Classroom Training - Coimbatore
Saravanampatty
Singanallur
Classroom Training - Bangalore
Marathahalli
Classroom Training - Madurai
Madurai
Online Training
Bangalore
Chennai
Coimbatore
Other City
Corporate Training
Interested in Corporate Training


	

	Select the Course
Trending Courses
AngularJS
Artificial Intelligence
Cloud Computing/AWS
Data Science
DevOps
Digital Marketing
Ethical Hacking
Full Stack
German
Japanese
JAVA/J2EE
Machine Learning using Python / R
MEAN
Python
Python with Machine Learning
RPA
Salesforce
Selenium
Software Testing
Spoken English
Cloud Computing
Azure
Cloud Computing/AWS
Google Cloud
Salesforce
VMWare
Web Design & Development
AngularJS
Drupal
Full Stack
Graphic Design
HTML5 & CSS
JavaScript
NodeJS
Photoshop
PHP/MYSQL
ReactJS
UI UX
Web Designing
WordPress
Programming
C/C++
Dot Net
Embedded
Go Programming
IoT - Internet of Things
JAVA/J2EE
Python
Mobile Application
Android
Flutter Dart
Ionic
iOS / Swift
Kotlin
React Native
Cordova/Phonegap
Software Testing Technologies
API Testing
ETL Testing
JMeter
LoadRunner
Manual Testing
Mobile Testing/Appium
Protractor
QTP/UFT
Selenium
Silk
Software Testing
Big Data
Big Data/Hadoop
Big Data Analytics
Spark
RPA Technologies
Automation Anywhere
Blue Prism
RPA
UiPath
Microsoft Technologies
Advanced Excel
SharePoint
JAVA
Core Java
Hibernate
JAVA/J2EE
Spring
Struts
Database
Oracle
Oracle DBA
SQL
Networking & Cyber Security
CCNA
Cyber Security
Ethical Hacking
Digital Marketing Training
Content Writing
Digital Marketing
Google Ads
Google Analytics
SEO
Social Media Marketing
Finance & Accounting
GST
Tally
BI and Data Warehousing
Clinical SAS
Data Science
Informatica
Power BI
R Analytics
SAS
Tableau
Talend
Language & Proficiency Exam
French
German
IELTS
Japanese
OET
Spanish
Spoken English
TOEFL
Career Development
Career Guidance
Leadership
Placement Training/Aptitude
Soft Skills
CRM & BPM Tools
JBPM
Microsoft Dynamics CRM
PEGA
Primavera
Others
Blockchain
HR
Inplant
Journalism
Sales
Unix/Linux
Other


	

	Planning to start Training
Immediately
In 2 Weeks
In a Month


	

	To use CAPTCHA, you need Really Simple CAPTCHA plugin installed.


	

	
	








      


    

  


                           

            
            

            
               
                  
                     Top Interview Questions & Answers

                  

                  
                     
                        
                             Digital Marketing Interview Questions and Answers

                             Java Interview Questions and Answers

                             Selenium Interview Questions and Answers

                             Hadoop Interview Questions and Answers

                             Python Interview Questions and Answers

                             AWS Interview Questions and Answers

                             DevOps Interview Questions and Answers

                             Oracle Interview Questions and Answers

                             PHP Interview Questions and Answers

                             AngularJs Interview Questions and Answers

                             Data Science Interview Questions and Answers

                             RPA Interview Questions and Answers

                             Software Testing Interview Questions and Answers

                             Mobile Testing Interview Questions and Answers

                             Salesforce Interview Questions and Answers

                             Networking Interview Questions and Answers

                             Pega Interview Questions and Answers

                             Node JS Interview Questions and Answers

                             Ethical Hacking Interview Questions and Answers

                             Javascript Interview Questions and Answers

                             Blue Prism Interview Questions and Answers

                             SEO Interview Questions and Answers

                             Android Interview Questions and Answers

                             Excel Interview Questions and Answers

                             Cloud Computing Interview Questions and Answers

                             Cyber Security Interview Questions and Answers

                             Tableau Interview Questions and Answers

                             Power BI Interview Questions and Answers

                        

                     

                  

               

            

            

            

            
               Recent Post: SubString In Python      
            

            

         
           
      

      
         
            
               
               




            

            
               Request a Batch
            

         

         

         
         
            

   Quick Enquiry

   
      
      Name is Required
      
   

   
      
      Valid EmailId is Required
       
   

   
      
      
         
         +91
UK (+44)
USA & Canada (+1)
Algeria (+213)
Andorra (+376)
Angola (+244)
Anguilla (+1264)
Antigua & Barbuda (+1268)
Argentina (+54)
Armenia (+374)
Aruba (+297)
Australia (+61)
Austria (+43)
Azerbaijan (+994)
Bahamas (+1242)
Bahrain (+973)
Bangladesh (+880)
Barbados (+1246)
Belarus (+375)
Belgium (+32)
Belize (+501)
Benin (+229)
Bermuda (+1441)
Bhutan (+975)
Bolivia (+591)
Bosnia Herzegovina (+387)
Botswana (+267)
Brazil (+55)
Brunei (+673)
Bulgaria (+359)
Burkina Faso (+226)
Burundi (+257)
Cambodia (+855)
Cameroon (+237)
Canada (+1)
Cape Verde Islands (+238)
Cayman Islands (+1345)
Central African Republic (+236)
Chile (+56)
China (+86)
Colombia (+57)
Comoros (+269)
Congo (+242)
Cook Islands (+682)
Costa Rica (+506)
Croatia (+385)
Cuba (+53)
Cyprus North (+90392)
Cyprus South (+357)
Czech Republic (+42)
Denmark (+45)
Djibouti (+253)
Dominica (+1809)
Dominican Republic (+1809)
Ecuador (+593)
Egypt (+20)
El Salvador (+503)
Equatorial Guinea (+240)
Eritrea (+291)
Estonia (+372)
Ethiopia (+251)
Falkland Islands (+500)
Faroe Islands (+298)
Fiji (+679)
Finland (+358)
France (+33)
French Guiana (+594)
French Polynesia (+689)
Gabon (+241)
Gambia (+220)
Georgia (+7880)
Germany (+49)
Ghana (+233)
Gibraltar (+350)
Greece (+30)
Greenland (+299)
Grenada (+1473)
Guadeloupe (+590)
Guam (+671)
Guatemala (+502)
Guinea (+224)
Guinea - Bissau (+245)
Guyana (+592)
Haiti (+509)
Honduras (+504)
Hong Kong (+852)
Hungary (+36)
Iceland (+354)
India (+91)
Indonesia (+62)
Iran (+98)
Iraq (+964)
Ireland (+353)
Israel (+972)
Italy (+39)
Jamaica (+1876)
Japan (+81)
Jordan (+962)
Kazakhstan (+7)
Kenya (+254)
Kiribati (+686)
Korea North (+850)
Korea South (+82)
Kuwait (+965)
Kyrgyzstan (+996)
Laos (+856)
Latvia (+371)
Lebanon (+961)
Lesotho (+266)
Liberia (+231)
Libya (+218)
Liechtenstein (+417)
Lithuania (+370)
Luxembourg (+352)
Macao (+853)
Macedonia (+389)
Madagascar (+261)
Malawi (+265)
Malaysia (+60)
Maldives (+960)
Mali (+223)
Malta (+356)
Marshall Islands (+692)
Martinique (+596)
Mauritania (+222)
Mayotte (+269)
Mexico (+52)
Micronesia (+691)
Moldova (+373)
Monaco (+377)
Mongolia (+976)
Montserrat (+1664)
Morocco (+212)
Mozambique (+258)
Myanmar (+95)
Namibia (+264)
Nauru (+674)
Nepal (+977)
Netherlands (+31)
New Caledonia (+687)
New Zealand (+64)
Nicaragua (+505)
Niger (+227)
Nigeria (+234)
Niue (+683)
Norfolk Islands (+672)
Northern Marianas (+670)
Norway (+47)
Oman (+968)
Palau (+680)
Panama (+507)
Papua New Guinea (+675)
Paraguay (+595)
Peru (+51)
Philippines (+63)
Poland (+48)
Portugal (+351)
Puerto Rico (+1787)
Qatar (+974)
Reunion (+262)
Romania (+40)
Russia (+7)
Rwanda (+250)
San Marino (+378)
Sao Tome & Principe (+239)
Saudi Arabia (+966)
Senegal (+221)
Serbia (+381)
Seychelles (+248)
Sierra Leone (+232)
Singapore (+65)
Slovak Republic (+421)
Slovenia (+386)
Solomon Islands (+677)
Somalia (+252)
South Africa (+27)
Spain (+34)
Sri Lanka (+94)
St. Helena (+290)
St. Kitts (+1869)
St. Lucia (+1758)
Sudan (+249)
Suriname (+597)
Swaziland (+268)
Sweden (+46)
Switzerland (+41)
Syria (+963)
Taiwan (+886)
Tajikstan (+7)
Thailand (+66)
Togo (+228)
Tonga (+676)
Trinidad & Tobago (+1868)
Tunisia (+216)
Turkey (+90)
Turkmenistan (+7)
Turkmenistan (+993)
Turks & Caicos Islands (+1649)
Tuvalu (+688)
Uganda (+256)
Ukraine (+380)
United Arab Emirates (+971)
Uruguay (+598)
Uzbekistan (+7)
Vanuatu (+678)
Vatican City (+379)
Venezuela (+58)
Vietnam (+84)
Virgin Islands - British (+1284)
Virgin Islands - US (+1340)
Wallis & Futuna (+681)
Yemen (North)(+969)
Yemen (South)(+967)
Zambia (+260)
Zimbabwe (+263)
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Tambaram
T Nagar
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Pondicherry
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AngularJS
Artificial Intelligence
Cloud Computing/AWS
Data Science
Data Analytics
DevOps
Digital Marketing
Ethical Hacking
Full Stack
German
JAVA/J2EE
Machine Learning using Python / R
MEAN
Python
Python with Machine Learning
RPA
Salesforce
Selenium
Software Testing
Spoken English
Azure
Cloud Computing/AWS
Google Cloud
Salesforce
VMWare
AngularJS
Drupal
Full Stack
Graphic Design
HTML5 & CSS
JavaScript
NodeJS
Photoshop
PHP/MYSQL
ReactJS
UI UX
Web Designing
WordPress
C/C++
Dot Net
Embedded
Go Programming
IoT - Internet of Things
JAVA/J2EE
Python
Android
Flutter Dart
Ionic
iOS / Swift
Kotlin
React Native
Cordova/Phonegap
API Testing
ETL Testing
JMeter
LoadRunner
Manual Testing
Mobile Testing/Appium
Protractor
QTP/UFT
Selenium
Silk Test
Software Testing
Big Data/Hadoop
Big Data Analytics
Spark
Automation Anywhere
Blue Prism
RPA
UiPath
Advanced Excel
SharePoint
Core Java
Hibernate
JAVA/J2EE
Spring
Struts
Oracle
Oracle DBA
SQL
CCNA
Cyber Security
Ethical Hacking
Content Writing
Digital Marketing
Google Ads
Google Analytics
SEO
Social Media Marketing
GST
Tally
Clinical SAS
Data Science
Data Analytics
Informatica
Power BI
R Analytics
SAS
Tableau
Talend
French
German
IELTS
Japanese
Spanish
Spoken English
TOEFL
Career Guidance
Leadership
Placement Training/Aptitude
Soft Skills
JBPM
Microsoft Dynamics CRM
PEGA
Primavera
Scrum Master
Blockchain
HR
Inplant
Journalism
Sales
Unix/Linux
Other
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                                        T.Nagar
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                                        FITA Academy - Velachery

Plot No 7, 2nd floor,

Vadivelan Nagar,

Velachery Main Road,

Velachery, Chennai - 600042

Tamil Nadu                                        :   93450 45466


                                

                            

                                                        
                                
                                        FITA Academy - Anna Nagar

No 14, Block No, 338, 2nd Ave,

Anna Nagar,

Chennai 600 040, Tamil Nadu

Next to Santhosh Super Market                                        :   93450 45466


                                

                            

                                                        
                                
                                        FITA Academy - T Nagar

05, 5th Floor, Challa Mall,

T Nagar,

Chennai 600 017, Tamil Nadu

Opposite to Pondy Bazaar Globus                                        :   93450 45466 


                                

                            

                                                        
                                
                                        FITA Academy - Tambaram

Nehru Nagar, Kadaperi,

GST Road, West Tambaram,

Chennai 600 045, Tamil Nadu
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5/350, Old Mahabalipuram Road,
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Arapalayam Cross Road,

Ponnagaram Colony,
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410, Villianur Main Rd,

Sithananda Nagar, Nellitope,

Puducherry - 605005
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UK (+44)
USA & Canada (+1)
Algeria (+213)
Andorra (+376)
Angola (+244)
Anguilla (+1264)
Antigua & Barbuda (+1268)
Argentina (+54)
Armenia (+374)
Aruba (+297)
Australia (+61)
Austria (+43)
Azerbaijan (+994)
Bahamas (+1242)
Bahrain (+973)
Bangladesh (+880)
Barbados (+1246)
Belarus (+375)
Belgium (+32)
Belize (+501)
Benin (+229)
Bermuda (+1441)
Bhutan (+975)
Bolivia (+591)
Bosnia Herzegovina (+387)
Botswana (+267)
Brazil (+55)
Brunei (+673)
Bulgaria (+359)
Burkina Faso (+226)
Burundi (+257)
Cambodia (+855)
Cameroon (+237)
Canada (+1)
Cape Verde Islands (+238)
Cayman Islands (+1345)
Central African Republic (+236)
Chile (+56)
China (+86)
Colombia (+57)
Comoros (+269)
Congo (+242)
Cook Islands (+682)
Costa Rica (+506)
Croatia (+385)
Cuba (+53)
Cyprus North (+90392)
Cyprus South (+357)
Czech Republic (+42)
Denmark (+45)
Djibouti (+253)
Dominica (+1809)
Dominican Republic (+1809)
Ecuador (+593)
Egypt (+20)
El Salvador (+503)
Equatorial Guinea (+240)
Eritrea (+291)
Estonia (+372)
Ethiopia (+251)
Falkland Islands (+500)
Faroe Islands (+298)
Fiji (+679)
Finland (+358)
France (+33)
French Guiana (+594)
French Polynesia (+689)
Gabon (+241)
Gambia (+220)
Georgia (+7880)
Germany (+49)
Ghana (+233)
Gibraltar (+350)
Greece (+30)
Greenland (+299)
Grenada (+1473)
Guadeloupe (+590)
Guam (+671)
Guatemala (+502)
Guinea (+224)
Guinea - Bissau (+245)
Guyana (+592)
Haiti (+509)
Honduras (+504)
Hong Kong (+852)
Hungary (+36)
Iceland (+354)
India (+91)
Indonesia (+62)
Iran (+98)
Iraq (+964)
Ireland (+353)
Israel (+972)
Italy (+39)
Jamaica (+1876)
Japan (+81)
Jordan (+962)
Kazakhstan (+7)
Kenya (+254)
Kiribati (+686)
Korea North (+850)
Korea South (+82)
Kuwait (+965)
Kyrgyzstan (+996)
Laos (+856)
Latvia (+371)
Lebanon (+961)
Lesotho (+266)
Liberia (+231)
Libya (+218)
Liechtenstein (+417)
Lithuania (+370)
Luxembourg (+352)
Macao (+853)
Macedonia (+389)
Madagascar (+261)
Malawi (+265)
Malaysia (+60)
Maldives (+960)
Mali (+223)
Malta (+356)
Marshall Islands (+692)
Martinique (+596)
Mauritania (+222)
Mayotte (+269)
Mexico (+52)
Micronesia (+691)
Moldova (+373)
Monaco (+377)
Mongolia (+976)
Montserrat (+1664)
Morocco (+212)
Mozambique (+258)
Myanmar (+95)
Namibia (+264)
Nauru (+674)
Nepal (+977)
Netherlands (+31)
New Caledonia (+687)
New Zealand (+64)
Nicaragua (+505)
Niger (+227)
Nigeria (+234)
Niue (+683)
Norfolk Islands (+672)
Northern Marianas (+670)
Norway (+47)
Oman (+968)
Palau (+680)
Panama (+507)
Papua New Guinea (+675)
Paraguay (+595)
Peru (+51)
Philippines (+63)
Poland (+48)
Portugal (+351)
Puerto Rico (+1787)
Qatar (+974)
Reunion (+262)
Romania (+40)
Russia (+7)
Rwanda (+250)
San Marino (+378)
Sao Tome & Principe (+239)
Saudi Arabia (+966)
Senegal (+221)
Serbia (+381)
Seychelles (+248)
Sierra Leone (+232)
Singapore (+65)
Slovak Republic (+421)
Slovenia (+386)
Solomon Islands (+677)
Somalia (+252)
South Africa (+27)
Spain (+34)
Sri Lanka (+94)
St. Helena (+290)
St. Kitts (+1869)
St. Lucia (+1758)
Sudan (+249)
Suriname (+597)
Swaziland (+268)
Sweden (+46)
Switzerland (+41)
Syria (+963)
Taiwan (+886)
Tajikstan (+7)
Thailand (+66)
Togo (+228)
Tonga (+676)
Trinidad & Tobago (+1868)
Tunisia (+216)
Turkey (+90)
Turkmenistan (+7)
Turkmenistan (+993)
Turks & Caicos Islands (+1649)
Tuvalu (+688)
Uganda (+256)
Ukraine (+380)
United Arab Emirates (+971)
Uruguay (+598)
Uzbekistan (+7)
Vanuatu (+678)
Vatican City (+379)
Venezuela (+58)
Vietnam (+84)
Virgin Islands - British (+1284)
Virgin Islands - US (+1340)
Wallis & Futuna (+681)
Yemen (North)(+969)
Yemen (South)(+967)
Zambia (+260)
Zimbabwe (+263)
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AngularJS
Artificial Intelligence
Cloud Computing/AWS
Data Science
Data Analytics
DevOps
Digital Marketing
Ethical Hacking
Full Stack
German
JAVA/J2EE
Machine Learning using Python / R
MEAN
Python
Python with Machine Learning
RPA
Salesforce
Selenium
Software Testing
Spoken English
Azure
Cloud Computing/AWS
Google Cloud
Salesforce
VMWare
AngularJS
Drupal
Full Stack
Graphic Design
HTML5 & CSS
JavaScript
NodeJS
Photoshop
PHP/MYSQL
ReactJS
UI UX
Web Designing
WordPress
C/C++
Dot Net
Embedded
Go Programming
IoT - Internet of Things
JAVA/J2EE
Python
Android
Flutter Dart
Ionic
iOS / Swift
Kotlin
React Native
Cordova/Phonegap
API Testing
ETL Testing
JMeter
LoadRunner
Manual Testing
Mobile Testing/Appium
Protractor
QTP/UFT
Selenium
Silk Test
Software Testing
Big Data/Hadoop
Big Data Analytics
Spark
Automation Anywhere
Blue Prism
RPA
UiPath
Advanced Excel
SharePoint
Core Java
Hibernate
JAVA/J2EE
Spring
Struts
Oracle
Oracle DBA
SQL
CCNA
Cyber Security
Ethical Hacking
Content Writing
Digital Marketing
Google Ads
Google Analytics
SEO
Social Media Marketing
GST
Tally
Clinical SAS
Data Science
Data Analytics
Informatica
Power BI
R Analytics
SAS
Tableau
Talend
French
German
IELTS
Japanese
Spanish
Spoken English
TOEFL
Career Guidance
Leadership
Placement Training/Aptitude
Soft Skills
JBPM
Microsoft Dynamics CRM
PEGA
Primavera
Scrum Master
Blockchain
HR
Inplant
Journalism
Sales
Unix/Linux
Other
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